## Contents

<table>
<thead>
<tr>
<th>DesignPro Tools Professional 3.00.28</th>
<th>.................................................................</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>10</td>
</tr>
<tr>
<td>Parsers ....................................</td>
<td>..................................................................................</td>
<td>10</td>
</tr>
<tr>
<td>Licensing ..................................</td>
<td>..................................................................................</td>
<td>10</td>
</tr>
<tr>
<td>Transformation Suite 8.00.28</td>
<td>..................................................................................</td>
<td>10</td>
</tr>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>10</td>
</tr>
<tr>
<td>Parser (AFP) ................................</td>
<td>..................................................................................</td>
<td>10</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.27</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>New Features ................................</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>Operating System Compatibility ......</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>Parser (PPFA) ................................</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>Form Editor ................................</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>Parsers (LCDS/Metacode) ..............</td>
<td>..................................................................................</td>
<td>11</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.26</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>New Features ................................</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>Converters (PCL) .........................</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>Converters ................................</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.24</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>New Features ................................</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>Converters (AFPDS) .......................</td>
<td>..................................................................................</td>
<td>12</td>
</tr>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Converters (Metacode) ...................</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>LCDS parser ................................</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Form Editor ................................</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Transformation Suite 8.00.24</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Parsers (LCDS/Metacode) ..............</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.23</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Fixs ........................................</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Form Editor ................................</td>
<td>..................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>Converters (OGL) .........................</td>
<td>..................................................................................</td>
<td>14</td>
</tr>
<tr>
<td>Manager ....................................</td>
<td>..................................................................................</td>
<td>14</td>
</tr>
<tr>
<td>Visual PPFA ................................</td>
<td>..................................................................................</td>
<td>14</td>
</tr>
<tr>
<td>Form Editor ................................</td>
<td>..................................................................................</td>
<td>14</td>
</tr>
</tbody>
</table>
Install ........................................................................................................................................... 19
Transformation Suite 8.00.20 .......................................................................................................... 20
New Features ................................................................................................................................... 20
Converters ....................................................................................................................................... 20
DesignPro Tools Professional 3.00.19 ............................................................................................. 20
New Features ................................................................................................................................... 20
Form Editor ...................................................................................................................................... 20
Font Editor ...................................................................................................................................... 21
Fixes ................................................................................................................................................ 21
Parsers ............................................................................................................................................. 21
Form Editor ...................................................................................................................................... 21
Resource Management System ...................................................................................................... 21
Transformation Suite 8.00.19 .......................................................................................................... 22
New Features ................................................................................................................................... 22
Parsers (LCDS/Metacode) ................................................................................................................ 22
DesignPro Tools Professional 3.00.18 ............................................................................................. 22
New Features ................................................................................................................................... 22
Licensing ....................................................................................................................................... 22
Fixes ................................................................................................................................................ 22
Install ............................................................................................................................................. 22
Manager ........................................................................................................................................ 22
Form Editor ...................................................................................................................................... 22
Graphics Editor ............................................................................................................................... 23
Manager & PrintDriver .................................................................................................................... 23
Parsers ............................................................................................................................................. 23
Converters ....................................................................................................................................... 24
PageMiner 4.00.18 ........................................................................................................................... 24
Fixes ................................................................................................................................................ 24
DesignPro Tools Professional 3.00.17 ............................................................................................. 25
New Features ................................................................................................................................... 25
Vitesse ............................................................................................................................................. 25
Resource Management System ....................................................................................................... 26
Fixes ................................................................................................................................................ 26
DesignPro Tools Applications ........................................................................................................ 26
Form Editor ...................................................................................................................................... 26
Font Editor & Graphics Editor ......................................................................................................... 26
Parsers ............................................................................................................................................. 26
Converters ....................................................................................................................................... 27
Elixir Transformation Suite 8.00.17 ................................................................................................... 28
Fixes ................................................................................................................................................ 28
Converters ....................................................................................................................................... 28
Converters (AFPDS) .......................................................................................................................... 38
Transformation Suite 8.00.14 ................................................................................................................. 38
Parsers (LCDS and Metacode).................................................................................................................. 38
PageMiner 4.00.14 ................................................................................................................................. 38
Parsers (LCDS and Metacode).................................................................................................................. 38
DesignPro Tools Professional 3.00.13 ........................................................................................................ 39
New Features........................................................................................................................................ 39
Resource Management System.............................................................................................................. 39
Vitesse.................................................................................................................................................. 39
Fixes...................................................................................................................................................... 39
DesignPro Visual PPFA............................................................................................................................ 39
PrintDriver ........................................................................................................................................... 39
Parsers (LCDS and Metacode).................................................................................................................. 39
Converters (PCL).................................................................................................................................... 40
DesignPro Tools Professional 3.00.12 ........................................................................................................ 40
New Features........................................................................................................................................ 40
DesignPro Manager, Visual PPFA and Form Editor ................................................................................ 40
Converters ............................................................................................................................................ 40
Fixes...................................................................................................................................................... 40
DesignPro Manager............................................................................................................................... 40
DesignPro Visual PPFA............................................................................................................................ 41
PrintDriver........................................................................................................................................... 41
Vitesse.................................................................................................................................................. 41
Fixes...................................................................................................................................................... 41
Parsers .................................................................................................................................................. 41
Converters ............................................................................................................................................ 42
DesignPro Tools Professional 3.00.11 ........................................................................................................ 42
New Features........................................................................................................................................ 42
Converters ............................................................................................................................................ 42
Fixes...................................................................................................................................................... 42
Vitesse.................................................................................................................................................. 42
DesignPro Applications............................................................................................................................ 42
DesignPro Form Editor, Visual PPFA and Elixir Viewer......................................................................... 43
DesignPro Form Editor ............................................................................................................................ 43
Converters ............................................................................................................................................ 43
Transformation Suite 8.00.11 ................................................................................................................. 43
New Features........................................................................................................................................ 43
Parsers (LCDS and Metacode).................................................................................................................. 43
Fixes...................................................................................................................................................... 44
Parsers (LCDS)...................................................................................................................................... 44
PageMiner 4.00.11 ................................................................................................................................. 44

www.elixir.com
<table>
<thead>
<tr>
<th>Version</th>
<th>New Features</th>
<th>Parsers</th>
<th>Fixes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DesignPro Tools Professional 3.00.07</td>
<td>New Features ..................................................................................................................... 50</td>
<td>Parsers (AFPDS) .......................................................................................... 50</td>
<td>Fixes............................................................................................................................... .... 50</td>
</tr>
<tr>
<td></td>
<td>Transformation Suite 8.00.07 .................................................................................................. 50</td>
<td>Parsers (GDF/Elixir Form) ........................................................................ 50</td>
<td>Converters (Metacode) ......................................................................................... 50</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.06</td>
<td>New Features ..................................................................................................................... 51</td>
<td>Parsers (LCDS)............................................................................................... 50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PrintDriver Pro .............................................................................................................. 51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.05</td>
<td>New Features ..................................................................................................................... 52</td>
<td>PrintDriver Pro ..................................................................................................... 51</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Visual PPFA .............................................................................................. 51</td>
<td>Elixir Viewer .................................................................................................. 51</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Manager ....................................................................................................... 52</td>
<td>PrintDriver Pro ..................................................................................................... 51</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Graphics Editor .......................................................................................... 53</td>
<td>Converters (AFPDS).......................................................................................... 51</td>
<td></td>
</tr>
<tr>
<td>Transformation Suite 8.00.05</td>
<td>Fixes............................................................................................................................... .... 53</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Form Editor .............................................................................................. 53</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Manager ....................................................................................................... 53</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro VPPFA .......................................................................................................... 53</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Graphics Editor .......................................................................................... 53</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Converters .................................................................................................................... 53</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.04</td>
<td>New Features ..................................................................................................................... 54</td>
<td>Parsers (FRM/FSL) .......................................................................................... 55</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Manager ....................................................................................................... 54</td>
<td>Converters ........................................................................................................... 54</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fixes............................................................................................................................... .... 55</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DesignPro Tools ........................................................................................................... 54</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Elixir Viewer .................................................................................................................. 55</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

www.elixir.com
<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DesignPro Form Editor</td>
<td></td>
<td>55</td>
</tr>
<tr>
<td>DesignPro Manager</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>DesignPro Font Editor</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>DesignPro VPPFA</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>PrintDriver Pro</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>Transformation Suite 8.00.04</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>Fixes</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>Parsers</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>Converters</td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>PageMiner 4.00.04</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>Fixes</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>Parsers (AFP)</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.03</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>New Features</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>DesignPro Manager</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>Fixes</td>
<td></td>
<td>57</td>
</tr>
<tr>
<td>Converters</td>
<td></td>
<td>58</td>
</tr>
<tr>
<td>DesignPro Font Editor</td>
<td></td>
<td>58</td>
</tr>
<tr>
<td>DesignPro Form Editor</td>
<td></td>
<td>58</td>
</tr>
<tr>
<td>DesignPro Graphics Editor</td>
<td></td>
<td>58</td>
</tr>
<tr>
<td>DesignPro Visual PPFA</td>
<td></td>
<td>59</td>
</tr>
<tr>
<td>Parsers (LCDS)</td>
<td></td>
<td>59</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.02</td>
<td></td>
<td>59</td>
</tr>
<tr>
<td>New Features</td>
<td></td>
<td>59</td>
</tr>
<tr>
<td>Converters (Image)</td>
<td></td>
<td>59</td>
</tr>
<tr>
<td>Parsers (GDF)</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>Fixes</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>DesignPro Manager</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>DesignPro Form Editor</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>DesignPro Visual PPFA</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>DesignPro Graphics Editor</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>Converters (GDF)</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>DesignPro Tools Professional 3.00.01</td>
<td></td>
<td>61</td>
</tr>
<tr>
<td>New Features</td>
<td></td>
<td>61</td>
</tr>
<tr>
<td>DesignPro Manager</td>
<td></td>
<td>61</td>
</tr>
<tr>
<td>PrintDriver Pro</td>
<td></td>
<td>61</td>
</tr>
<tr>
<td>Fixes</td>
<td></td>
<td>62</td>
</tr>
<tr>
<td>DesignPro Visual PPFA</td>
<td></td>
<td>62</td>
</tr>
<tr>
<td>DesignPro Font Editor</td>
<td></td>
<td>62</td>
</tr>
<tr>
<td>Parsers (PPFA)</td>
<td></td>
<td>62</td>
</tr>
<tr>
<td>Converters</td>
<td></td>
<td>62</td>
</tr>
</tbody>
</table>

www.elixir.com
These release notes describe changes to the above products and contain descriptions of features not in our documentation. All updates are cumulative; changes made in previous updates are included in this release. This release must be applied on top of the base release 3.00, and will update each of the above products if installed.

DesignPro Tools Professional 3.00.28

Fixes

Parsers

AFP
Font References Retained
Font settings in records are retained while opening PageDefs. Previously, font references greater than 127 were replaced with the default font.

OGL
OGL Files Parse Successfully
Form Editor no longer crashes while parsing OGL files.

ELX/GDF
Paragraph Formatting Retained
ELX files parse successfully and hence, paragraph formatting settings are retained.

Licensing

Elixir Licensing Services Enabled
For Local licensing, Elixir License Client and Elixir License Server services are enabled only when Opus is already installed.

Transformation Suite 8.00.28

Fixes

Parser (AFP)

Shading Displays Properly
AFP files parse properly and hence, correct shading is viewed in both Elixir Viewer & the PDF output.

AFP Files Parse Successfully
AFP files parse successfully and hence, convert to PDF format successfully.
DesignPro Tools Professional 3.00.27

New Features

Operating System Compatibility

Supported Operating Systems
DesignPro Tools is compatible with the following operating systems:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Compatibility with DPT Release (Patch)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citrix XenDesktop</td>
<td>3.00.25 or later</td>
</tr>
<tr>
<td>Windows 7 Professional (32-bit)</td>
<td>3.00.22 or later</td>
</tr>
<tr>
<td>Vista Enterprise (32-bit)</td>
<td>3.00.07 or later</td>
</tr>
<tr>
<td>Windows 2000, NT</td>
<td>3.00.00 or later</td>
</tr>
</tbody>
</table>

Fixes

Parser (PPFA)

FIELD’s Text Construct Properly
The FIELD’s text command containing multiple text types parses and displays properly in Visual PPFA without generating any error messages.

Form Editor

Join By Spaces Functions Properly
The Join By Spaces option functions properly for all text directions and page orientations. Transformation Suite 8.00.27

Fixes

Parser (LCDS/Metacode)

Converting Large LCDS Files without Error
The Out of Memory message no longer displays during LCDS to PostScript conversion of large files.
DesignPro Tools Professional 3.00.26

New Features

Converters (PCL)

VMI for PCL Macro Provided
A new checkbox Use Default VMI is added to the Main category of the PCL Converter to insert PCL Macros in the output file. When checked, the default value for Vertical Motion Index (VMI) is used and the value 8 is written in the PCL output.
Note: By default, this option is unchecked and the value 0 is written in the PCL output.

Fixes

Converters

FRM
FRM Prints Successfully
The system no longer generates an error during printing and hence, an FRM generated from ELX prints successfully.

Metacode
Character Display Correctly
Italicized characters display correctly and no longer overlap.

DesignPro Tools Professional 3.00.24

New Features

Converters (AFPDS)

Compressed Images Export Successfully
A new checkbox TIFF LZW (Full Color IM) is added to the Images category of the AFPDS converter. Checking this option exports the LZW compressed images successfully while saving an AFP overlay.

Text Translates Properly
A new checkbox Use Referred Code Page is added to the Encoding category of the PPFA parser/converter for ASCII encoded text. Checking this option translates the text using the code page referred in the coded font.
Note: The code page must exist on the system for proper text translation.
Fixes

Converters (Metacode)

- **Shaded Areas Display Properly**
  During conversion to Normalized Metacode, the shaded areas no longer break and display properly.

- **Conversion Occurs Successfully**
  DesignPro Manager no longer hangs while converting the files from EFR to NOR.

- **Color Resets in Colored Normeta Output**
  DesignPro Tools applications reset colors at the end of each colored job. Hence, the merging of NOR files from DPT and EAS results in correct output.

**LCDS parser**

- **Tags Convert Correctly**
  During MET to ELX conversion, the tags convert properly and the **Field Gen** property appears correctly.

**Form Editor**

- **Extra Vertical Lines No Longer Appear**
  While converting an EFR to FRM, no extra vertical lines appear.

Transformation Suite 8.00.24

Fixes

**Parsers (LCDS/Metacode)**

- **Crash No Longer Occurs**
  Crash no longer occurs when the customer’s specific LCDS file is opened in Elixir Viewer/Page Miner or converted to PDF.

DesignPro Tools Professional 3.00.23

Fixes

**Form Editor**

- **Button Active Object Settings Preserved**
  For the Button active object, the URL and other Action settings are preserved properly.
**Converters (OGL)**

**Extra Spaces No Longer Generated in Barcode Text**
While converting an EFR to OGL, extra spaces are no longer generated in the barcode text. Moreover, the optional parameter 2DPARMS generates properly.

**Manager**

**EFR Files Convert to Normeta Successfully**
DesignPro Manager no longer hangs while converting customer’s specific EFR file to Normeta.

**Visual PPFA**

**Large FormDefs Open without Error Messages**
The Out of Memory message no longer displays while opening and closing large FormDefs.

**Form Editor**

**Forms Save Properly**
A form is considered as modified when the **Merge Form Group** operation is performed and hence, you are prompted to save the form before exiting.

**Transformation Suite 8.00.23**

**Fixes**

**Parsers (LCDS/Metacode)**

**Text Displays Correctly**
The font height is calculated properly and hence, the text displays with correct line spacing.

**PageMiner 4.00.23**

**Fixes**

**Parsers**

**LCDS/ Metacode**
COPIES Command Provided
Support of COPIES command with multiple FORMS parameters in DJDE command is provided. Using the COPIES parameter you can specify the number of copies for the next report. Moreover, you can apply different forms on each copy of the report using multiple FORMS parameter.
AFP Files Successfully Convert to PCL Format
AFP files convert to PCL format without crashing. In addition, the output PCL files are viewed properly in Elixir Viewer.

### DesignPro Tools Professional 3.00.22

#### New Features

**Manager**

**Searched Forms Open in Associated Applications**
When searching for resources in forms using the Resource Search feature, you can click a form (*.EFR, *.ELX, *.FRM) returned in a search result to display it in the associated application such as Form Editor or Elixir Viewer.

To open a form containing the searched resource:
1. Click the Resource Search tab in the Manage window.
2. Specify the required resource search criteria.
3. Click Search.
   - Search results display in the list box.
4. Click the file name of any of the form files returned in the search.
   - The selected file opens in Form Editor or Elixir Viewer.

**Parser (AFP)**

**LZW Compression Supported During Parsing**
LZW compression is supported by the AFP parser.

**Converters (OGL)**

**OCA Color Model Added**
The OCA color model is available with other pre-defined color models in the Color category enabling you to generate OGLs with OCA colors.

**Fixes**

**Form Editor**

**Shaded Boxed Display Correctly**
Shaded boxes display correctly on opening a form in Form Editor.
Visual PPFA

Overlays Saved at Correct Location
Overlays save at the specified locations when editing AFP FormDefs and/or PageDefs.

**Note:** To edit an overlay, right-click the overlay inserted in the FormDef, PageDef or Template Overlays Tree, and select **Open Form for Edit** from the pop-up menu; the Form Editor toolbar adds to the Visual PPFA workspace and the overlay becomes editable.

PageMiner 4.00.22

Fixes

Converters (Text)

Records Generated Successfully
Records are no longer removed in AFP to TextData or Text format conversion.

DesignPro Tools Professional 3.00.21

New Features

DesignPro Tools Applications

Opening Multiple Files at a Time
Using the *Open* dialog for Form Editor, Font Editor and Graphics Editor, you can select and open multiple files simultaneously. You can also drag and drop multiple files onto Form Editor from Windows Explorer.

To open multiple files simultaneously, in the *Open* dialog, do one of the following:
- To select non-adjacent files, select a file, and then press **Ctrl** and select each additional file.
- To select adjacent files, select the first file in the sequence, and then press **Shift** and select the last file.

Form Editor

Applying Application Grid Settings
A new checkbox *Use Application’s Grid Settings While Loading Form* is provided in the *Tools, Application, Grid* dialog. When checked, the form being opened uses the application’s grid settings while loading.

**Note:** This option is unchecked by default.

VPPFA

Suppressing Field Text
A new checkbox *Show Suppressed Field’s Text* is provided in the *Tools, Options, Application, Editor* category. When unchecked, the suppressed field’s text is hidden on the Design Area. This option is checked by default.

This new checkbox is independent of the *Suppression* option in the *Tools, Options, Application, Borders & Colors* category.
Vitesse

Online Help Updated
The updated Vitesse Online Help is provided.

Fixes

Form Editor

- **Height of USPS 4State Barcode**
  The USPS 4State barcode generates with proper height.

- **Line Spacing for Signature Font**
  The line spacing for signature font is handled properly and hence, the signature font is typed and rendered properly.

VPPFA

- **Character Range for POSTNET Increased**
  VPPFA supports characters range between 0 - 50 for POSTNET barcode Mod X'03'.

- **Empty Delimited Fields Handled Properly**
  For empty delimited FIELDS, the length of the FIELD's name is used while placing the text with Replacement Characters option for old PageDef designs. Hence, VPPFA no longer hangs.

Manager

Handling Metacode Tag Field Length and Depth Values
Tag Field Length and Depth values are handled properly by using the tags keys (Field ID/Number) given in Metacode.

Vitesse

- **OMR Bars Vertical Position**
  For Line Mode projects, the vertical position of Optical Mark Recognition (OMR) Bars is calculated from the top of the page instead of the bottom.

- **Page Numbers Printed for All NUP Options**
  For Database Mode projects, the page numbers print for all NUP printing options.

Parsers

OGL
Text for Repeating Boxes Displays Correctly
OGL correctly parses the BOX n and WITHTEXT command and hence, the text displays properly for repeating boxes.

PCL
Viewing PCL Files
Transparent print data handling is enhanced in PCL parser, and PCL files display properly in Elixir Viewer.
**Licensing**

Deactivating the License File
You can deactivate the license file on a computer using `Deactivate.exe` and the **Deactivate License** option in License Wizard. After the completion of the deactivation process, an encrypted file creates in the current directory. You need to email this file to Elixir Customer Support in order to get a new license file.

---

**PageMiner 4.00.21**

**Elixir Scout Manager**

LCDS Jobs Process Successfully
All LCDS jobs processed through Elixir Scout Manager complete successfully without any runtime errors.

**DesignPro Tools Professional 3.00.20**

**New Features**

**Form Editor**

Tag Definition Default Behavior
The **Tools > Options > Application, Tag Ref** category has a new option **Delete After Use**. Check **Delete After Use** to delete a data field after it has been used. Uncheck this option if the same field is required later in the document. Any new tag inherits this default property; however, the value of the property can be modified for individual tags.

**Note:** This option is checked by default.

Backup Form Files
Backup files (*.BAK) are created for all form formats supported by Form Editor. The backup files are created in the same directory as the original form file.

To enable backup file creation:

1. From the Tools menu, select Options.
2. In the Application, Editor category, under Filing Options, check Make Backup Files.

**Note:** This option is unchecked by default.

**DesignPro Tools Applications**

Opening Multiple Files at a Time
Using the **Open** dialog for Form Editor, Font Editor and Graphics Editor, multiple files can be selected and opened simultaneously. Also multiple files can be dragged and dropped onto the Form Editor from Windows Explorer.

To open multiple files simultaneously, in the **Open** dialog, do one of the following:
- To select non-adjacent files, select a file, and then press **Ctrl** and select each additional file.
- To select adjacent files, select the first file in the sequence and then press **Shift** and select the last file.
Manager

Transformer Tool
The Transformer tool retains the values of user specified output paths for the duration of a Manager session.

Overwriting Files
The Tools > Options > Conversion category has a new option Prompt Before Overwriting. This option is enabled when the Overwrite Files option is checked. Check Prompt Before Overwriting to display a dialog confirming if you want to overwrite an existing file. Uncheck this option to overwrite files without prompting for confirmation.

Note: This option is unchecked by default.

Fixes

Form Editor

Form General Settings
Form identification information such as the author, company name, version number, etc. specified in the Tools > Options > Page, General category is saved and displayed properly.

Font Editor

PCL Fonts Loading
PCL fonts open and display correctly in Font Editor. The font files can also be converted to other formats using Converters.

DesignPro VPPFA

Fonts Replacement
Elixir fonts replace AFP Coded fonts of the same name, and the appropriate font icons display in the Font List dialog.

Install

Elixir Licensing Services
The Elixir License Client and Elixir License Server services are disabled for the Local licensing mode and enabled for the Network licensing mode by default.

AFPDS/OGL

Conversion Messages
Informational messages display when image resources (*.LP3, *.BMP) in a form are converted to AFP format. The messages are generated for all options under the Include Images category.

To generate the conversion messages:
1 As appropriate, do one of the following:
   From the AFPDS dialog, select the Images category.
   Or
   From the OGL dialog, select the Resources, Image category.
2 Under \textit{Include Images}, select any of the following options:

- \textbf{Never} (Default selection)
- \textbf{Always Inline (B/W Pattern)}
- \textbf{To External Resource File}

\textbf{Transformation Suite 8.00.20}

\textbf{New Features}

\textbf{Converters}

\textbf{PDF}

PDF Raster Operations

In the PDF dialog, \textit{Main > Optimization} section has a new option \textit{Ignore Raster Operations}. Check \textit{Ignore Raster Operations} to generate a PDF without transparency. Uncheck this option to generate a PDF file with transparency. Checking this option can affect the fidelity of the generated PDF if the input file contains overlapping objects in mixing mode. Also by selecting this option, any transparency in the input file is lost. This option is unchecked by default.

\textbf{DesignPro Tools Professional 3.00.19}

\textbf{New Features}

\textbf{Form Editor}

PDF Accessibility Features

\textbf{Accessibility} is added to the \textit{Properties-Object Type} dialog. This feature lets you perform the following tasks:

- \textbf{Alternate Text}: adds alternate text to image and barcode objects. This alternative text is used to provide a textual replacement for pictures (images). The textual replacement conveys the same message as communicated to a sighted user seeing the image.
- \textbf{Natural Language}: sets a natural language (e.g. French, English) for a text object within a document. To set the natural language for a page, from the \textit{Tools} menu, select \textbf{Options, Page, General}.
- \textbf{Reading Order}: sets the reading order of objects. For this feature, a new tab \textit{Object Reading Order} is provided in the \textit{Manage} window. You can drag and drop objects within this tab to set the reading order of objects. This option is also available in the \textit{Properties-Object Type} dialog in read-only mode.

\textbf{Note}: To enable these options: From the \textit{Tools} menu, select \textbf{Options, Application, General}. From the PDF Accessibility area, check Accessibility Options. This option is unchecked by default.

Change in Units Display Format

A new checkbox \textit{Show Values in Fractional Units} is added to the \textit{Ruler} category of the \textit{Options} dialog in the \textit{Tools} menu. When checked, Form Editor behaves as default and the units display in fractions. When unchecked, the units display in whole numbers. The change in unit display format is also reflected in the following:

- Common Attributes toolbar
- Form Properties dialog
- Options dialog (both at Application and Page level)

This option is only available in Form Editor for all objects except barcode for the following units: Dots, Pels, Twips and Points.

\textbf{Note}: This option is checked by default.
Opening a New Form
A new option **Open with New Form** is added to the **General** category of the **Options** dialog in the **Tools** menu. When checked, Form Editor opens with a new form. When unchecked, Form Editor opens with a blank workspace.

**Note:** This option is checked by default.

Displaying Thickness in Dot Units
A new option **Always Use DOT Units for Line Thickness** is added to the **Ruler** category of the **Options** dialog in the **Tools** menu. When checked, the line thickness for all objects is shown in dots only. When unchecked, all the measurements are shown in specified units.

**Note:** This option is unchecked by default.

**Font Editor**

- **Printing Sample Characters**
  A new option **Print Sample** is added to the **View** menu and the **Preview** toolbar to print sample characters.

**Fixes**

**Fixes**

**Parsers**

- **Metacode**
  ELX Files Convert to NORMETA Successfully
  With shaded box objects, the number of records is decreased. In addition, Manager no longer hangs while converting such files.

- **PCL**
  Text Objects No Longer Overlap
  The text objects do not overlap in Elixir Viewer and hence, PCL files display correctly.

- **FRM**
  Shaded Box Objects Display Properly
  Shaded boxes no longer split in FRM files with Highlight color.

**Form Editor**

- **Undo Command Works Correctly**
  The **Undo** command functions properly when working with image objects.

**Resource Management System**

- **Unnecessary Security Alerts No Longer Display**
Transformation Suite 8.00.19

New Features

Parsers (LCDS/Metacode)

Encoding and Delimiter Options
Two new options Encoding and Delimiter are added to the Record Format dialog. Using these options, you can select encoding and delimiter values from either:
- The JSL file
- The Record Format dialog

In the Encoding drop-down list, if the Default option is selected then encoding is used from the JSL file, otherwise encoding set in the Record Format dialog is used.
Similarly, in the Delimiter drop-down list, if the Default option is selected then the delimiter value is used from the JSL file, otherwise value specified in the Delimiter entry box is used.

DesignPro Tools Professional 3.00.18

New Features

Licensing
Network License Support Provided
Elixir provides network license support for the DesignPro Tools Professional, DesignPro Tools for AFP and DesignPro Tools for Xerox packages. This feature is currently not available for the DesignPro Tools Form Editor package.

Fixes

Install
Duplicate Program Folder No Longer Created
Installing the patch does not create a duplicate Program folder.

Manager

Typing Capital A when Naming a Mapped Folder
When naming a mapped folder, capital A can be typed by pressing Shift + A.

Form Editor

Text No Longer Shifts when Editing
A new checkbox Ignore Control Chars Width is added under Text Formatting in the Main category of the GDF parser. When checked, the width of the control characters is ignored and as a result, the text does not shift on editing. By default, this option is checked for backward compatibility.
**Graphics Editor**

ASCII Character Range Increased
The standard upper ASCII character limit is increased from 127 to 255. You can use the new upper character limit to convert images into fonts.
The following error message generates when the number of glyphs exceeds the new upper ASCII character limit: **Too many glyphs to accommodate in a character set.**

**Manager & PrintDriver**

ASCII Character Range Increased
The standard upper ASCII character limit is increased from 127 to 255. You can use the new upper character limit to convert images into fonts.
The following error message generates when the number of glyphs exceeds the new upper ASCII character limit: **Number of tiles/glyphs exceeds 256, conversion aborted. Please change image tiling option(s).**

Auto-Population of Tag and Comment Entry Boxes
A new checkbox **Populate Tag/Comments from Latest Version** is provided. When checked, the Tag and Comment entry boxes in the Check In dialog are automatically populated with the latest versions of tag and/or comment information from the main/parent file during the check in operation.
In DesignPro Tools applications, this checkbox is available in the **Tools, Options, RMS** dialog.
In Resource Management System, this checkbox is available in the **Tools, Options** dialog.
**Note:** By default, this option is unchecked.

Login Issue Resolved
While logging in, the Invalid Username and Password error message does not display after upgrading the patch.

**Parsers**

**AFP**
IBM Compiled OVE Parses Successfully
IBM compiled OVE is parsed successfully.

**PPFA**
POSTNET Bar Code Selection No Longer Generates an Error Message
SRC Pagedef files with POSTNET barcode open properly in Visual PPFA without generating any error messages.

**Metacode**

- **Optimized Text Support Provided**
  With optimized text support, the following issues are resolved:
  1) Number of text record counts reduced by a good percentage.
  2) Multiple font usage in a single text line is provided.
  3) Highlight color for text displays properly.
  You need to select **Optimize Output Size** in the Text category of the Metacode converter to activate the above mentioned changes.

- **Space Character is No Longer Inserted**
  Space character is not inserted between two words when the Metacode converter performs the text joining operation internally to reduce record count and hence, the created NOR file appears fine in Elixir Viewer.
Converters

**AFP**

Precise Insertion of Prefix in EFR to OVE Conversion
For EFR to OVE conversion with DOS/VSE record format, 'O1' prefix is accurately added to the output file name.

**FRM**

- **KMP Mapping Works Properly**
  KMP mapping works properly when converting a Windows True Type font to Xerox FNT font.

- **Metacode Commands Translated Properly**
  The special Metacode commands are not translated into characters and are ignored during the writing of FRM.

- **Invalid Image Reference No Longer Generated**
  FRM created for printer type 87/97XX V10 no longer generates an invalid image reference and GHO bit is not set by default.

Elixir/GDF converter

Elixir Fonts Exported Without the C0 Prefix
In OVE to ELX conversion, simple Elixir fonts are exported without the C0 prefix.

**Metacode**

Italicized Text Formats Correctly
A new checkbox **Ignore Kerning** is added under **Use EAS Compatible Fonts** that lets you manage text kerning and hence, italicized text formats correctly. This new feature works properly if **Optimize Output Size** is checked.

Note: Ignore Kerning is available in the Resources, Fonts category.
Optimize Output Size is available in the Conversion, Text category.

PageMiner 4.00.18

Fixes

**Parsers (AFP)**

Low Memory Utilization during Conversion
Memory utilization remains low during the conversion of large AFP files and hence, **Out of memory** error message is no longer generated and these files convert fine into PDF and other supported output formats.
New Features

Vitesse

Optical Mark Recognition (Bubbles and Bars)

The Optical Mark Recognition (OMR) Bubbles and Bars feature is available for Line, Database, Native, XML and Form applications. OMR is a method of computerized input from paper forms.

OMR Bubbles have four components Map String, Slug Char, Response String and the OMR grid. The Slug Char defines the shape of bubbles, the Response String is a string of characters corresponding to the bubbles, and this string is compared to the Map String. The characters from the Response String together with OMR Bubbles form an OMR grid.

The table below elaborates the placement of the OMR Bubbles on the OMR grid with respect to Map String and Response String:

<table>
<thead>
<tr>
<th></th>
<th>Vertical OMR</th>
<th>Horizontal OMR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map String</td>
<td>Determines the row in which Response String characters lie on the OMR grid.</td>
<td>Determines the columns in which response string characters lie on the OMR grid.</td>
</tr>
<tr>
<td>Response String</td>
<td>Determines the column in which Response String characters lie on the OMR grid.</td>
<td>Determines the row in which Response String characters lie on the OMR grid.</td>
</tr>
</tbody>
</table>

OMR Bars represent actions that you want the printer to perform on a document while printing. To define these actions, set the properties of OMR Bars from Vitesse.

Using Xerox Raster Fonts in Vitesse

You can use Xerox Raster Fonts in Vitesse applications. After installation, a new folder named "Raster" adds to the Fontlib directory: drive:\Program Files\Elixir Technologies\Vitesse\FontLib. Place all your Raster fonts (FNT files) in this folder and restart Vitesse.

**Note:** If this folder does not already exist, add a new folder and rename it to Raster. Place your Raster fonts in this folder.

To remove Xerox Raster Fonts, simply delete the font files (FNT). However, do not delete files with extension other than FNT, as they are necessary for the proper functioning of Vitesse.

**Note:** Some additional files are required to support rendering and Postscript conversion of Raster fonts. Contact Elixir Support for these files, or use Elixir Design Pro tools for this purpose.
Resource Management System

Incremental Backup Support
You can make incremental backups of your files that have changed since the last backup. On executing the backup manually from Resource Management Administrator, the system will perform inclusive backup for the first time, and then it will perform incremental backup.
In incremental backup only the changed files are copied from the resource folder drive:\Data. However, database files are copied as a whole.
To set the location for incremental backup:
1. Log in to Resource Management Administrator.
2. Click the Options tab.
3. Specify the Resource Location, Server Port and Backup Location.
4. Click Update.

Backup can also be initiated from Command Prompt using the following switch:
-u <Username>, -p <Password>, -o <Backup Location> -c <Company Name>
Note: The Company Name is mandatory if username is not "sysadmin".

This switch also lets you schedule backups through Elixir Scout.

Fixes

DesignPro Tools Applications

Arrow Signs No Longer Printed
The arrow signs at top right of the tag elements are no longer printed when Print as Image option is checked in the Print dialog.

Form Editor

Correct Justification Settings Display in the Properties Dialog

Font Editor & Graphics Editor

Shortcut Key for RMS Dialog Changed to Ctrl + Shift + A
The shortcut key for opening the RMS Add dialog is changed from Shift + A to Ctrl + Shift + A. Shift +A key combination can be used to enter capital A.

Parsers

EFR
- Invisible Text Objects Removed
  The invisible text objects in an EFR are removed when a file is opened and hence, the file converts to FRM format successfully.
PDF
- Images and Footnotes Display Correctly
  Images and footnotes display in correct locations on a landscape page.

Converters

FRM
- Calculating Font's Average Character Spacing
  A new Use Unicode Range checkbox is provided in the Fonts category of the Xerox LPS Resource Writer dialog. When checked, the average character spacing is calculated from the Unicode range. When unchecked, the average character spacing is calculated using the ASCII range, which is the default behavior.
  Note: By default, this option is unchecked.

Metacode
- Suppressing DJDE Color Commands
  A new checkbox Suppress DJDE Color Commands is provided in the Color category of the Metacode dialog. When this option is checked, then DJDE with color commands ICATALOG=XEROX,PALETTE='SIMPLE',IDFAULT='RED' are suppressed in the Normeta/Metacode generated output.
  Note: By default, this option is unchecked.

- Page Bottom Marker Set Properly
  The page bottom marker is set properly when Auto is selected from the Main category of the Metacode dialog.

FSL Converter
- Include All Fonts Functions Properly
  The Include All Fonts option functions properly and the order of the fonts set by you remains intact in the converted FSL file. This option is available in the Resources category of the Xerox FSL Writer dialog.

GDF
- Correct Text Orientation is Used
  Proper text orientation is used when a Microsoft Word document is converted to ELX format with Use Unicode Always checked. This option is available in the Fonts category of the ElixirForm dialog.
Elixir Transformation Suite 8.00.17

Fixes

Converters

PDF
- Substitute Solid Color for Shades Functions Properly
  The Substitute Solid Color for Shades checkbox available in the Main category of the PDF dialog functions properly.

ElxConverter
- AFP Files Convert to PDF Format Successfully
  AFP format files convert successfully to PDF format and the resource missing message is not generated.

Licensing

License Key Expiry Date
The license key no longer expires one day before the expiry date.

PageMiner 4.00.17

Fixes

Parsers (LCDS\Metacode)

Line Skips Execute Properly
Line skips execute properly and data on all pages is consistent with the printed scans.

DesignPro Tools Professional 3.00.16

Licensing

New Registration Process
The new registration process is provided in DesignPro Tools Professional 3.00.15 patch and higher. You may receive your software license through various channels: download your (electronic) license from the Elixir web site (preferred method); request a hard-key (dongle) from Elixir Customer Support; or receive a special license via e-mail from Elixir Support.

To register your copy of the software:

1. From the Start menu, select All Programs, Elixir Applications, Application Name, and Product Registration.
   The License Wizard displays.
2 Check **Show Advanced Options** to see all options:
- Downloading a Product License. This is for software-based license keys only.
- Selecting a License. You must specify whether the license key is located on a local computer or on a network server.
- Viewing a License.
- Deactivating a license.
- Installing a License.

**Downloading a Product License**
The following section describes how to download a software-based license key from the Elixir web site. (You may also request a software-based license key from Elixir Customer Support.)

To download a product license using the Internet:

1. From the **Welcome** dialog, choose **Download Product License** and click **Next**.
   The Login Information dialog displays. The login information for your installation is provided in your Customer Activation Letter.
   If you are not already connected to the Internet, you will need to connect before continuing with registration.

2. As appropriate, enter or review the following:
   - **Locking Code**
     Machine serial number used for license string generation.
   - **Customer Number**
     Unique number identifying customer.
   - **PC Number**
     Unique number identifying computer.
   - **Password**
     Unique name or code for accessing computer.
     **Note:** Links next to the entry boxes are currently not available.

3. Click **Next**.
   The Contact Information dialog displays. Verify that all information is correct before proceeding.
   **Note:** If the information displayed in this dialog is not correct, you can change it by clicking the link on top of the information box, or by clicking **Back**.

4. Click **Next**.
   The Download Progress dialog displays.
   Once your registration is complete, the Registration Completed dialog displays your license information.

5. Click **Finish** to complete your registration.
   The software is registered. A password.epw file is placed in the `drive:\Elixir` folder.

**Selecting a License Source**
To select the source of your license (local or network license):

1. From the **Welcome** dialog, choose **Select License Source** and click **Next**.
   The License Information dialog displays. Select the license key or license server from the drop-down list. Each license key’s information displays.
   - **Items**: name of the license key
   - **Start Date** and **Expiry Date** of the license key.
   You can click **Check All Licenses** to select all licenses at once. By default Elixir client service connects to local license server. You can also check **Detect Network Servers** to look for network servers.
If your license key is not available in the drop-down list, click to locate the file on your computer. You can either download a license key from the Elixir web site or you can contact Elixir Customer Support to receive the password file. See Downloading a Product License. The password file must be located in the drive:Elixir root folder.

2 Click Next.
   The Registration Completed dialog displays with registered items on your machine.

3 Click Finish to complete your registration.
   The software is registered.

Viewing a License
To view the available license keys on your computer:
1 From the Welcome dialog, choose View License Information.
2 Click Next.
   The License Information dialog displays. Select the license key from the drop-down list. Each license key’s information displays.
   • Items: name of the license key
   • Start Date and Expiry Date of the license key.
   • Locking code: machine serial number used for license string generation.
3 Click Finish.

Deactivating a License
You may need to deactivate a license if you are moving a license from one computer to another. You can only deactivate a license a limited number of times. Thereafter you must contact Elixir Customer Support.

To deactivate a previously registered license on your computer:
1 From the Welcome dialog, choose Deactivate License.
2 Click Next.
   A warning displays.
3 If you are sure you want to continue, click Next.
   If you are not already connected to the Internet, you will need to connect before continuing.
4 As appropriate, enter or review the following:
   • Locking Code
     Machine serial number used for license string generation.
   • Customer Number
     Unique number identifying customer.
   • PC Number
     Unique number identifying computer.
   • Password
     Unique name or code for accessing computer.
     Note: Links next to the entry boxes are currently inactive.
5 Click Next.
   The Contact Information dialog displays.
6 Review the contact information and click Next if it is correct.
   The Deactivation progress dialog displays.
   If the information displayed in this dialog is not correct, you can change it by clicking the link on top of the information box, or by clicking Back.
7 Click Finish to exit the License Wizard.
   The selected customer license is deactivated.
Installing a License

After you have downloaded the software-based license key or received it from Elixir Customer Support, you must use License Wizard to install it:

1. From the Welcome dialog, choose Install License.
2. Click Next.
   The Install License dialog displays.
3. Click Browse to locate the license key file on your computer.
4. Select *.epw from the Files of Type drop-down list and browse to select the license key file.
5. Click Open to select the file and return to the Install License dialog.
6. Click Next.
   The Install Status dialog displays.
7. Click Finish to complete the license installation.
   The software is now registered.
8. Click Finish to exit the Install License wizard.

DesignPro Tools Applications

- Barcode Rendering Library Updated
  The library used for rendering barcodes has been updated to the most recent release. Certain barcodes used within Visual PPFA, Form Editor and Elixir Viewer may present slight changes in height and strip during rendering. This change only affects the screen display and does not have an impact on the PageDef or in printing.

- Support for Intelligent Mail Barcode
  You can add Intelligent Mail Barcodes (US4STATE) in Form Editor and VPPFA. VPPFA successfully parses and converts OBJ and SRC files with Intelligent Mail Barcodes.

Resource Management System

Adding Companies

Any user with the System Administrative rights may create and manage companies on RMS Server by using Resource Management Administrator application. A company in RMS is assigned its own set of users, roles and resources. You can log in to Resource Management Administrator and create companies, then assign users and roles to these companies. The users must select a company at the time of login.

In addition, you can also purge resources, export resources and view activity logs for different companies.

To create a company:

1. Log in to Resource Management Administrator.
   The Resource Management Admin window displays.
   **Note:** To add companies, you must use default user name “sysadmin” and password “sysadmin” to log in to Resource Management Administrator. You can then add companies for other users.

2. Click the Company Management tab.
   The Company Management view displays. This tab only displays if you log in to Resource Management Administrator using the “sysadmin” username and password.

3. Right click in the left column of this view and select Add Company from the pop-menu.
   The Add Company dialog displays.

4. Enter the Company Name and click Add.
   The new company is successfully added to the left column.
To assign users, roles, purge resources, export resources, and view activity logs for a company using the sysadmin login:

5 Log in to Resource Management Administrator.
   The Resource Management Admin window displays.

6 Click the required tab.

7 From the Administrator toolbar, select the required company from the drop-down list.

8 Perform the required task.
   For details, refer to the Recourse Management System User Guide.

   Note: Selecting a company from the list displays the associated users, roles and resources.

Elixir Resource Map

GRID Mapping

Three new options Font Name, GCSGID, and FGID are provided in the Grid area for AFPDS font in the Font Mapping dialog. These options provide mappings for AFP fonts generated from True Type fonts using the specified Font Name, GCSGID and FGID settings. If a Font Name is not specified in the Grid area, then it is generated by default. For document/form conversion, if both Font and GRID mappings are defined against the same True Type font, precedence is given to Font mapping.

   Note: These options are enabled when Global Font Resource ID (GRID) option is selected from the Action area for AFPDS fonts in the same dialog.

Utilities (EFRINV)

Rotating EFRs

EFRINV Utility lets you rotate EFR files.

Usage: EFRINV -i <INPUT EFR file> | -d <Directory Name> | -o <OUTPUT INV file> | -c <.epm file> | -x <Inversion Mode> | -a <Rotation Angle>;

Where:
   -i : Input EFR file to be inverted (.EFR). Wildcards are allowed.
   -d : Directory name for batch inversion.
   -o : Output INV file (.INV).
   -c : Elixir Configuration file (.EPM).
   -x : Mode of inversion.
   -a : Angle of rotation. Possible rotation values are 90, 180 and 270. If no value is provided, then the file is rotated by 180 degrees.

Converters

AFPDS

Segmenting IPD Records

A new check-box Use Technology Maximum (32kb) Size Limit is added to the Image category of the AFPDS dialog. When checked, the IPD records in the PSEG output are segmented into 32kb blocks; else, IPD records are segmented into 8kb blocks. By default, this option is unchecked.

   Note: This new feature is part of DesignPro Tools Professional 3.00.15 patch and higher.

Metacode

- Selecting the JSL File

   A new Browse button is added against the JDL entry box located in the Job category of the Metacode dialog. You can browse and select a JSL file for the current Metacode conversion and the logo coordinates are written with respect to PMODE given in the JSL file.
Reducing the Output File Size
The functionality of **Optimize Output Size** is enhanced and hence, the file size is further reduced.

*Note:* This option is available in the **Conversion, Text** category of the **Metacode** dialog.

**Fixes**

**Elixir Scout Manager**

**Using PrintDriver With Elixir Scout Manager**
Proper EPM settings are shown and used when a conversion through PrintDriver is automated with Elixir Scout Manager using the **DDE Server** commands. For successful conversion, you must check **Autorun (no windows, messages to log file)** available under the **Options** tab in the **PrintDriver Options** dialog.

*Note:* To open the **PrintDriver Options** dialog: browse to `drive:\Program Files\Elixir Technologies\bin` and double-click **PrintDriverOptionsAppU**.

**PrintDriver Pro**

**Displaying Record Format Options**
All **Record Format** options display in the **AFPDS** dialog while converting through Elixir PrintDriver Pro.

**Vitesse**

**Selecting Text in Text Objects**
While editing, the text in text objects is selected properly in all project modes, for all supported languages.

**Parsers (OGfIL)**

**Loading OGLs with Missing Segment Names**
In case of a missing segment name, OGL parser properly loads the segment using its member ID/Seg ID.

**Converters (PDF)**

**Adding Tags to PDF Files**
Tags add successfully to PDF output files.
Elixir Transformation Suite 8.00.16

New Features

Parsers (DocInLCDS)

Creating the Document Media Entry in the Output file
A new entry box Default Feed Tray is added to the Other category of the LCDS dialog. If the default feed tray is provided, then it will be used for pages that do not have any media specified in JSL/Data and hence, PostScript converter will create Document Media Entry accordingly.

PageMiner 4.00.16

Fixes

Parsers (LCDS\Metacode)

PDE FONT Support
Support for PDE FONT with over written line spacing is provided and the data is positioned properly while parsing.

DesignPro Tools Professional 3.00.15

New Features

Parsers (GDF)

Unique Tag Field Number
A new checkbox Generate Unique Tag Field Number is added to the Tags category of the ElixirGDF dialog.

On checking this option, GDF Parser automatically assigns unique Tag IDs/Field Numbers to any duplicate Tag IDs/Field Numbers in the form and thus tags appear properly in view.

The newly added option is unchecked by default.

Vitesse

Chinese Support
Vitesse™ provides Chinese support to help you create projects that use either Chinese language only or Chinese and English languages. The Chinese text feature is available in all project modes. You can add Chinese text in Text, Field, Variable, Chart and Condition objects. Each object can hold data in both languages. You can also map data from data files containing Chinese text. In addition, you can import RTF files containing Chinese text and add Chinese text to existing projects.

The following limitations apply:
- Chinese font typeface names are not supported.
- VIPP only supports resource names in English.
Converting Mapped TrueType Fonts to CID Fonts

CID (Character Identifier) fonts support Chinese text; therefore, it is recommended that you convert all TrueType fonts used for Chinese text in your application to CID fonts. CID fonts are a new format of composite (multibyte) Type 1 fonts that better address the requirements of Far East markets.

To convert a mapped TrueType font to CID font: From the Tools menu, select Preferences. From the Preferences dialog, select the CIDFontMap category. Select the required font and click Convert Selected Fonts.

Note: The end-user is solely responsible for ensuring that the conversion of any font into another format is permissible pursuant to the end-user's license agreement for the font. Elixir disclaims all responsibility for ensuring that the conversion of any font into another format is permissible pursuant to the end-user's license agreement for the font.

Importing VPCs

Import feature is not available in Line mode. However, it is available in Native, DB, and XML modes.

Note: Vitesse™ imports back its own generated VPCs correctly (Native, DB, and XML mode VPCs without frames); however, externally created VPCs are imported only if all commands, constructs and features used are supported by Vitesse™.

Fixes

Resource Management System

Change Password

You can change the password of a user account successfully using Resource Management Portal.

Note: The Change Password option is available in the Manage Users tab.

Get Local Copy Option

Don't Get Local Copy option in the Check Out dialog is replaced with Get Local Copy option and works fine. Also, Create Repository option in the context sensitive menu is spelled correctly.

Elixir Applications

Printing Multiple Files

The Print as Image option is now available in Elixir Viewer and DesignPro Tools Manager hence, multiple files can now be printed with this option.

Note: This option is available in the Tools and Utilities tab of DesignPro Tools Manager.

Rendering of Lines for Rotated Overlays

Lines of all thickness values render correctly when overlays containing these lines are rotated by 90, 180 or 270 degrees.

Form Editor

Merging Overlays

Now forms merge properly in Form Editor and no error messages display.

Note: The Merge Form Group option is disabled when no form is open. This option is available in the File menu of Form Editor.
PrintDriver Pro

Font Mappings
Word files convert successfully with correct font mappings if proper resource searching order and parser properties are provided in the Config file used for conversion.

To select the Config file: from the Print Driver Options dialog, click the Options tab and in the Config File entry box, enter the file path or browse to it. The Browse button for Config File is now set to drive:\Documents and Settings\All Users\Application Data\Elixir Technologies\DesignPro Tools by default.

Note: Create a settings file (.EPM) with proper resource search order and parser properties using any DPT application and select it as the Config file.

Converting Word Files with Text Boxes
Word files using text boxes now convert properly if Ignore Invisible Boxes option is checked. Selecting this option ignores the boxes with white fill color and thus no shading will appear in background.

Note: To check this option: from the Windows EMF dialog, select the General category. In the Objects area, check Ignore Invisible Boxes.

Parsers

AFPDS:
Barcode Positioning
OVE compiled on mainframe is now loading properly in Form Editor and Barcode objects are positioned properly inside the page.

FRM:
Converting Graphics in RGB Format
Word documents with graphics now convert successfully in RGB format without changing text color to Red.

Note: Select Images in the Resources category and check the Use Simplifier option to get the correct output color.

EMF:
Converting Word Files with Text Boxes
Word files using text boxes now convert properly if Ignore Invisible Boxes option is checked. Selecting this option ignores the boxes with white fill color and thus no shading will appear in background.

Note: To check this option: from the Windows EMF dialog, select the General category. In the Objects area, check Ignore Invisible Boxes.

GDF:
Joining Text
Text now joins properly without misplacement and formatting issues when Synthesizer is used.

Note: To use Synthesizer: from the GDF/ElixirForm dialog, select the Synthesizer category and provide appropriate settings.

Manage Window Information
Form Editor no longer crashes while loading ELX files and displays proper object information on the Manage window.

Note: To display the Manage window: in Form Editor, from the View menu, select Manage.
FSL:
Text Alignment
FSL is parsed properly and text is now centered in boxes.

Note: In case of any syntax violation, an error message displays.

Converters (Metacode)

Optimized Output File Size
To achieve lower record count and reduced file size in output NOR file: while conversion, from the Text category, in the Optimize area, check Optimize Output Size. Unchecking this option creates a record for each word and will result in a higher record count and output file size.

Note: Higher record counts may impact printer performance.

Elixir Transformation Suite 8.00.15

Fixes

parsers (PCL)/ Converters (PS/PDF)

Text and Graphic Positioning
PCL files convert successfully to PDF without downward shifting of text baseline. Text and charts also line up properly.

DesignPro Tools Professional 3.00.14

Form Editor

Saving Changes in Forms
Changes made to the form are marked and hence, you are prompted to save the form before exiting.

Opening OGL Files
OGL files can be opened even after removing the extension.

Shaded Box Objects
Shaded box objects do not split into multiple smaller box objects.

Color Category
The behavior of the Color category available in the object Properties dialog is the same for both AFP and Hybrid toolsets.

Visual PPFA

Mixed Mode Data Files
Mixed mode data files are loaded properly in Visual PPFA and hence, structured fields display correctly.

Mapping Fields Using Drag and Drop Method
When data is mapped from the Sample Data window to the design area using the Drag and Drop method, the field is created under an existing unmapped record. Visual PPFA looks for the first unmapped record after the last mapped record in the PageDef, and consumes it first.
Save Message Displayed
A message to save the document is prompted whenever you change the length of a data field in the Sample Data window.

VPPFA No Longer Crashes
VPPFA does not crash while performing Cut, Copy, Paste, Move (Drag and Drop) operations on SubGroups in FormDefs. Import and Export operations are also working properly for all FormDef formats [*.efd, *.obj, *.src]. After proofing, the correct output is shown in Elixir Viewer.

Parsers (AFPDS)

IOCA CCITT 4 Compression
Overlays generated with IOCA CCITT 4 Compression load and print efficiently.

Overlays Show Correct Shading
Overlays are loaded successfully and shading applied to box objects displays correctly.

Fonts Not Removed from Font List
Fonts are not removed when an image is replaced in an Overlay. The original font list is maintained.

IOCA CMYK JPEG Compression
Page segments with IOCA CMYK JPEG Compression load and convert to other formats without generating any error messages.

Font Handling
The AFP fonts in which the font maximum and uniform metrics per each of the orientation (one, two, three, or four) do not have corresponding font size metrics are loaded correctly in DesignPro Tools applications. However, an error message "Error: AFPDS Parser: Invalid field 89AC (FNP (Font Position)) detected during parsing of character set C0TOF13P data stream" is generated as such fonts are not correct according to AFP font specifications.

Converters (AFPDS)

IOCA CCITT 4 Compression
Overlays generated with IOCA CCITT 4 Compression load and print efficiently.

Transformation Suite 8.00.14

Parsers (LCDS and Metacode)

Converting LCDS Jobs to PDF Format
LCDS jobs are converted to PDF format without crashing.

PageMiner 4.00.14

Parsers (LCDS and Metacode)

Line Spacing
Line spacing is handled properly and hence, data is displayed correctly.
New Features

Resource Management System

The Resource Management System (RMS) is integrated with DesignPro Tools to help manage resources easily within the DesignPro Tools editors. The integrated portion of RMS within DesignPro Tools is license activated and part of a full Resource Management System install.

For more information on the Resource Management System, please see the Resource Management System User Guide available on the download section of our web site.

Vitesse

Hebrew Support
Vitesse™ provides Hebrew support to help you create projects that use either Hebrew language only or Hebrew and English languages. The Hebrew text feature is available in all project modes. You can add Hebrew text in Text, Fields, Variables, Charts and Condition objects. Each object can hold data in both languages. You can also map data from data files containing Hebrew text. In addition, you can import RTF files containing Hebrew text and add Hebrew text to existing projects.

Note: For more information, please see the Vitesse™ Hebrew Support User Guide available with Vitesse™ 2.10.03 (Stand-alone).

Saving Font Style
A new option Save All Font Styles is added to save the font styles specified during project creation. To do so, from the Tools menu, select Preferences. From the dialog that displays, select the General category and check Save All Font Styles. All font styles specified in the Font tab of the Properties View window are saved with the project.

Fixes

DesignPro Visual PPFA

REVERSE for DIRECTION Sub-Command
REVERSE for DIRECTION sub-command successfully parses and displays properly in Visual PPFA. In addition, proofing generates correct output in Elixir Viewer.

PrintDriver

DAT File
DAT file is created while converting a file to GDF format document via Elixir PrintDriver Pro. The DAT file is placed at the following location: drive:\Elixir\Docs\Elixir\.

Parsers (LCDS and Metacode)

Support for Variable Length Blocks
LCDS and Metacode parsers support variable length blocks. Previously, fixed blocks of size 540 bytes were supported.
Converters (PCL)

**Preserve EAS Compatibility**
Preserve EAS Compatibility option is enabled and checked by default. When checked, the file generated would contain positioning compatible to EAS.

*Note:* This option is available in the **Main** category of the **PCL** dialog. Previously, this option became available on checking **Print as Macro**.

DesignPro Tools Professional 3.00.12

New Features

**DesignPro Manager, Visual PPFA and Form Editor**

**Replacing Image Dimensions**
A new option **Use New Image's Dimensions** is added to use the dimensions of the new image. When unchecked, the dimensions of the previous image are used. When checked, the dimensions of the new image are used. This option is checked by default.

*Note:* In DesignPro Manager, this option is available in the **Resource Search** tab of the **Manage** window. In DesignPro Form Editor and Visual PPFA, this option is available in **Editor** category of the **Options** dialog.

**Converters**

**Image and FRM:**
**Resampling Images**
A new option **Resample** is added to the **Image** and **Xerox LPS Resource Writer** dialogs. When checked, the image is resampled to the target dimensions. When unchecked, the image is either padded or cropped, depending on the target dimensions.

*Note:* This option is enabled only when **Preserve EAS Compatibility** is checked.
In **Xerox LPS Resource Writer** dialog, this option is available in the **Resources - Images** category. In **Image** dialog, this option is available in the **Images** category.

**FRM:**
**Printing OGLs**
A new option **Create Two TL/DL Entries** is added to the **Xerox LPS Resource Writer** dialog. When checked, the FRM converter writes 2 calls for colored LGOs with half glyphs. When unchecked, the FRM converter writes 1 call for colored LGOs with full glyphs.

*Note:* This option is checked by default. This option is available in the **Resources - Images** category of the **Xerox LPS Resource Writer** dialog.

Fixes

**DesignPro Manager**

**Packaging EFR File**
EFR file is properly tracked when dropped on to **Resource Package** tab of the **Manage** window. On creating a package, the charset and codepages are successfully added to the Zip file.
DesignPro Visual PPFA

Opening Pagedefs
VPPFA does not crash while loading/unloading Pagedefs repeatedly.

PrintDriver

Paper Size
All standard paper sizes display in the Elixir PrintDriver Pro Advanced Options dialog.

Vitesse

Key Code for Vitesse Demo with Restrictions
The key code for Evaluation Mode of Vitesse (Vitesse DEMO) has been extended. Previously, only ‘GB’ (Vitesse Demo) key code was used. Effective this patch, new key code ‘VR’ (Vitesse Demo with Restrictions) can also be assigned.

After installing this patch, the license file generates against the new key code ‘VR’. All the features which were present in Vitesse DEMO are made available, except for the following:

- You can create a Vitesse project but not save it.
- You cannot Package the project.
- You cannot view the generated VIPP source code.
- You cannot run Export (VPC) from Vitesse.

Sample projects are provided with this Vitesse patch for demo purpose only. You can use Export (VPC) feature only on these sample projects, run proofing, and obtain physical prints from VIPP enabled printers.

Fixes

Parsers

AFPDS:

- Barcode HRI Font
  The HRI (Human Readable Interpretation) text for a Barcode displays using the correct True Type font.

- Exporting Fonts
  Fonts are exported properly when an EFR is converted to OVE. Hence, no error messages are generated when a converted OVE is opened in DesignPro Form Editor.

PPFA:
Barcode Modwidth Value
If no value for the Barcode Modwidth is specified, then PPFA parser automatically sets the value to 13.
**Converters**

**GDF:**

*Applying Interior Color to Path Objects*

Interior color is properly applied to path objects in ELX files.

**OGL:**

*CHAR Command*

OGL converter successfully writes the CHAR sub-command for BPSD tags.

**PPFA:**

*CONSTANT Command*

PPFA converter writes the CONSTANT command in correct sequence and hence, the file parses properly.

**Image:**

*Compression and Resolution Settings*

Correct compression and resolution settings are used when converting a form or an image to the Image File format.

---

**DesignPro Tools Professional 3.00.11**

**New Features**

**Converters**

**GDF:**

*Exporting Images*

A new checkbox **Export Images as Necessary** is added to Images category of GDF/ElixirForm dialog. When you check this option, only those images are exported that are necessary to maintain the form fidelity.

**Note:**

This option is checked by default. To check/uncheck this option: from the Tools menu, select Application Format Settings, Output Formats, ElixirGDF. In the Images category, check/uncheck **Export Images as Necessary**.

In the Images category, if Export Images as Necessary and Export External Image Resources are unchecked, no image is exported. The corresponding informational messages display in the Messages window.

**Fixes**

**Vitesse**

**VIPP Fonts**

VIPP fonts added to the FontMap category of the Preferences dialog display correctly in the Font tab.

**Note:**

- To open the Preferences dialog: From the Tools menu, select Preferences.
- To select a VIPP font: Click the Font tab, and select VIPP from font Type. Select the required font from the Name drop-down list.
DesignPro Applications

Open Operation Optimized
Large image files of all types take less time to open. The performance of this operation on large files is improved by 200%.

DesignPro Form Editor, Visual PPFA and Elixir Viewer

Finding/Searching for Text
When you search for text using the Find dialog, whether an occurrence of the text is found or not, the control remains in the Find dialog and you can continue with the next search.

Note: To search for a text, from the Edit menu, select Find. The Find dialog displays. In the Find entry box, enter the text you want to search.

DesignPro Form Editor

Image References in Manage Window
When you convert EFR files to FRM format, the LGO images are properly converted and image reference appears once in the Manage window.

Converters

Metacode:
DMGIMAGBEG/ DMGIMAGEND Comments Display Correctly
When you convert a DAT file to Normalized Metacode format, the DMGIMAGBEG and DMGIMAGEND comments display correctly, indicating the beginning and end of an image in the file.

AFP:
Save and Conversion Operations Optimized
Large image files save and convert to AFP Page Segments in less time. The performance of these operations on large files is improved by 200%.

GDF:
Font Names/References Display Correctly
The NOR files convert to ELX format properly and font /names/references display correctly.

Transformation Suite 8.00.11

New Features

Parsers (LCDS and Metacode)

Negative Relative Shifts
A new checkbox Ignore Negative Shifts is added to Other category of LCDS dialog. When you check this option, any occurrence of negative relative shift in a line or box is ignored.

Note: To check this option: Perform the required input settings and click Set. The LCDS dialog displays. In the Other category, check the Ignore Negative Shifts.
Fixes

Parsers (LCDS)

Duplex Jobs with Page Skip and ANSI CC
When you parse LCDS files, the page skip in a duplex job containing ANSI CC works properly. Hence, the files display correctly.

PageMiner 4.00.11

New Features

Parsers (LCDS and Metacode)

Barcodes Display Correctly
A new checkbox Process Width/Height > 14 as Landscape is added to Page category of LCDS dialog. When you check this option, barcodes and other contents in the page display properly.

Note: To check this option: Perform the required input settings and click Set. The LCDS dialog displays. In the Page category, check the Process Width/Height > 14 as Landscape.

Fixes

Parsers (LCDS)

One Page Jobs with ANSI CC
The LCDS jobs containing one page and ANSI CC parse correctly.

DesignPro Tools Professional 3.00.10

New Features

Parsers (AFPDS)

RGB Tiled (3 bands) Images
AFPDS parser supports parsing of RGB tiled (3 bands) images.

Fixes

DesignPro Visual PPFA

Documents with NUPs
Documents containing NUPs display correctly in Visual PPFA.
**DesignPro Font Editor**

**Preserving Word and Figure Space Values**  
Word Space and Figure Space values for AFP fonts save correctly in Font Editor.

**Note:** To set these options: from the View menu, select Font Properties, Char Set Increment. The Char Set Increment dialog displays. From the Formatting area, enter the required values in Word Space and Figure Space entry boxes. The Font Properties option is enabled only when a font is opened in Font Editor.

**PrintDriver Pro**

**Accessing Local Profiles**  
When using PrintDriver Pro you can access both local and shared/global profiles.

**Note:** To access local profiles: browse to drive:\Program Files\Elixir Technologies\Bin and double-click on PrintDiverOptionsAppU.exe to open the PrintDriver Options dialog. Select the Options tab and click Profile Selection. The Profile Selection dialog displays. The Profile Name drop-down list contains names of both local and shared profiles.

**Elixir Scout Manager**

**DDE Server Commands**  
The DDE Server commands work correctly when you enter a user name and password for a Scout job.

**Parsers (AFPDS)**

**Saving Files to OBJ Format**  
AFPDS parser successfully opens Pagedef files in OBJ format that contain conditions. To do this, you need to select the proper text encoding format from the Condition drop-down list in the AFPDS input properties dialog. Hence, the Pagedef file can be saved back to your required format.

**Note:** To set this option: from the Tools menu, select Application Format Settings, Input Formats, AFPDS. The AFPDS dialog displays. Select the PageDef category. In the Text Encoding area, select the required encoding format from the Condition drop down list.

**Converters (OGL)**

**Blank Lines in OGL Format Files**  
When you convert a form to OGL format file with Use CL/RF option checked, the OGL format file contains blank lines. However, blank lines do not display when this option is unchecked.

**Note:** To set this option: from the Tools menu, select Application Format Settings, Output Formats, OGL. The OGL dialog displays. Select General category and in the Source Coding area, check the Use CL/RF option.
Transformation Suite 8.00.10

Fixes

Parsers

LCDS and Metacode

Page Breaks
LCDS files with page breaks at the end of a duplex job parse correctly and hence, files display properly.

FSL, FRM and LCDS

JPG Images
FSL/FRM/LCDS parsers properly invoke the next parser set in Resource Searching Order list in the Elixir dialog. This lets you parse image types not supported by Xerox (such as JPG) by adding the GDF parser at the next priority level.

Note: To set the GDF parser priority level: from the View menu, select Options. From the Options dialog, select the Conversion tab. Enter the EPM file name in the Elixir Internal Setup File entry box. Click the Set button to open the Elixir dialog. Select the Resources category, and from the Available Resource Converters list, select ElixirGDF. Click # to add it to the Resource Searching Order list. You can change the priority of the parser by clicking # or # in front of the Resource Searching Order list.

DesignPro Tools Professional 3.00.09

New Features

Converters

PDF:
Font Options for Active Objects
Font options Face Name, Point Size are added to Default Font area of the Active Objects category in the PDF converter.

- Face Name drop-down list lets you select a True Type font for active objects.
- Point Size entry box lets you set the size of the font. By default Point Size is set to 10.

Note: Raster fonts used for active objects are replaced by the selected font.

GDF:
Advanced Tab Support
A new checkbox Advanced Tab Support is added to the Main category of the ElixirForm converter.

If you check this option and save the ELX file in Form Editor, the Default Tab Stop Value (specified under the Pages, Tabs category of the Options dialog) is preserved such that on reopening the ELX file, the preserved Default Tab Stop value is used for all the tab characters on the current form.

If you open such an ELX file with an earlier version of DPT, the tab characters will continue to occupy 5 spaces (instead of the tab character) as in previous releases.

Note:
- The minimum Default Tab Stop value is increased from 0 to 0.005 inches.
- The Advanced Tab Support option is unchecked by default.
Fixes

**DesignPro Form Editor**

- **Selecting and Deselecting Objects**
  - To select one or more objects, press `Shift` and left click on the required objects. The objects on which you clicked are selected only.
  - To deselect one or more selected objects, press `Shift` and left click on the required objects. The objects on which you clicked are deselected only.

- **Saving Spell Checker Changes**
  Changes made by the Spell Checker are now marked and hence, you are prompted to save the form before exiting.

- **Font Lists for Multiple Forms**
  The drop-down list shows correct font lists for each form when multiple forms are opened in Form Editor.

  **Note:** drop-down list is located on the Text Attributes toolbar.

**DesignPro Visual PPFA**

- **Offsets on Changing Overlays**
  Default vertical and horizontal offsets (0, 0) are applied when the overlays are changed in Enhanced NUP or Properties-NUP dialog.
  
  **Note:** Enhanced NUP dialog can be accessed by selecting Enhanced in NUP Type in the Presentation category of the FormDef/Copygroup dialog.
  
  Properties-NUP dialog can be accessed by right-clicking Front/Back Place and selecting Properties.

- **Selecting and Deselecting Objects**
  - To select one or more objects, press `Shift` and left click on the required objects. The objects on which you clicked are selected only.
  - To deselect one or more selected objects, press `Shift` and left click on the required objects. The objects on which you clicked are deselected only.

**DesignPro Font Editor**

**Underscore values in AFP Fonts**
When you save AFP fonts in Font Editor, the underscore values are preserved correctly. In addition, the font works properly when used with underlined text in Form Editor.

**Converters (Metacode)**

- **Font Listing**
  Font List options in the Font List area of the Fonts category in the Metacode dialog are working properly.
  - To include/export all (used and unused) fonts, select Include All Fonts.
  - To include/export fonts referred in the form/document only, select Include Used Fonts Only.

- **Data Fragmentation**
  Records appear correctly at the same position as in ELX format. Tabs in text now convert using relative positions and hence, EFR files convert properly without fragmentation.
Transformation Suite 8.00.09

Fixes

**Parsers (LCDS and Metacode)**

**Page Overlapping**
LCDS files with page skip parse correctly and hence, pages do not overlap.

**Blank First Page**
Page skips at the start of LCDS jobs are processed properly and a blank page appears in the output correctly.

**Data Shifting**
LCDS files with consecutive page skips parse correctly and data displays properly.

DesignPro Tools Professional 3.00.08

New Features

**Converters (AFPDS)**

**Mapping Options for IOCA Images**
Mapping options (None, Position and Trim, Scale to Fit, Center and Trim, Scale to Fit) are added in Images category when IOCA is selected from the Image Format area.

Note: These options display only in DesignPro Graphics Editor and DesignPro Manager and are applicable only when image resources convert into AFP Page Segments.

DesignPro Applications

**Mapped Folders in Open/Save/Resource Insertion Dialogs**
Open any DesignPro application:

1. Open any open/save/resource insertion dialog.
2. Select the required resource type from the Files of Type drop-down list.
3. Select Elixir in the left pane of the dialog.
   The Elixir button in the open/save/resource insertion dialogs points towards the mapped folder against the selected resource type.
   If multiple folders are mapped against a single resource type and the first mapped folder does not exist, then the DesignPro application will check for the next mapped folder until an existing folder is found.
   If no mapped folder exists, the application prompts you to create the first mapped folder. On clicking Yes, the folder is created and displayed in the dialog. If the application fails to create the specified mapped folder, a message “Could not create” is displayed and the path remains unchanged in the dialog. The path also remains unchanged on clicking No.
Fixes

DesignPro Form Editor and Visual PPFA

Toolbar Spin Controls in Windows XP - French
Spin control buttons are working correctly in DesignPro Form Editor and DesignPro Visual PPFA when applications are executed in Windows XP French operating system.

Converters

AFPDS:
Graphics Objects with Zero Width and Height
The graphic objects (Box, Circle, Line, etc.) with zero width and height are discarded by AFPDS converter.

Image:
Compression of TIFF Images
The TIFF images converts correctly with proper compression when Compression type is selected in the Image category for Tiff Image Format.

Transformation Suite 8.00.08

Fixes

Parsers (LCDS)

Files with Font Index and Carriage Control (CC) at Same Index
LCDS files having Font Index and CC (Carriage Control) at same index '0' are parsed correctly.

PageMiner 4.00.08

Fixes

Parsers

FRM
Form/Data Files without Scan Line/Dot Address
FRM files without scan lines and/or dot address generated for the old 87/97XX V10 printers parse correctly with USLEGAL paper size. Hence the form and data are appearing at correct position.

LCDS
- Logical Page Skip
  Files with logical page skip parses correctly and data is appearing at right position so now classification and mining completes successfully.

- Font Line Spacing
  Font line spacing in the first line of the first page is now working correctly for LCDS jobs and data is placed correctly on the page.
DesignPro Tools Professional 3.00.07

New Features

Parsers (AFPDS)

Resampling Images to Object Area Size
A check box Resample Image to Object Area Size is added to the General category of the AFPDS parser. Checking this option resamples the AFP Page Segments to object area size while parsing.

Fixes

Parsers (GDF/Elixir Form)

Wrapped/Joined Text Displays Correctly
Text is wrapped/joined correctly if proper Text Join options are set in the GDF/Elixir Form dialog.

Note: To set the text join options, from the Tools menu, select Application Format Setting, Input Format, ElixirGDF. From the dialog that displays, select the Synthesizer category. Check Use Synthesizer and select Text Join option from the drop-down list. Specify the required options.

Converters (Metacode)

Landscape Pages Print and Display Correctly
Landscape pages generated using Metacode converter display and print correctly.

Transformation Suite 8.00.07

Fixes

Parsers (LCDS)

- Duplex Printing
  LCDS parser prints data on the backside of the page for BFORM = NONE.
- Empty Pages no Longer Display
  LCDS parser provides support for all values of PCC parameter ADVTAPE. Hence, forms are printed using the appropriate orientation.
New Features

PrintDriver Pro

**Image to Font Conversion**
A new check box **Tile Image into Font (valid for ASCII Fonts)** is added to the **General** category of WindowsEMF parser to convert images to fonts via PrintDriver Pro. By default, this option is unchecked. When you check this option, images present in the form are converted into fonts as in Elixir Application Suite. This option is valid for ASCII fonts only.

If the number of glyphs exceed 256 (ASCII font limit), then a message box will appear during conversion and the conversion will abort.

Fixes

DesignPro Visual PPFA

**Proper Overlays Display under SubGroups**
Visual PPFA processes Source/SRC FormDefs containing overlay lists correctly and hence proper overlays display under SubGroups.

Elixir Viewer

**Opening AFP Documents with Large Number of Records**
AFP documents containing large number of records on a single page now take reasonable time to open in Elixir Viewer.

PrintDriver Pro

**Granting Read and Write Access Rights**
For proper working of PrintDriver under a user account with limited access rights, this installer performs the following actions:

- Assigns read and write access rights to "Everyone" group on drive:\Documents and Settings\All Users\Application Data\Elixir Technologies\ folder.
- Creates a file named DISK under drive:\Elixir\Pdnt\ folder (if it does not exist) and assigns the "Everyone" group rights to this file.

**Note:** Installing this patch on PrintDriver Pro grants these access rights to all users of DesignPro Tools applications.

**Proper Handling of Paths with Space Characters**
PrintDriver Pro properly handles paths containing space characters.

Converters (AFPDS)

**Image Width in Multiples of 8**
A check box **Align Image Width to Multiple of 8** is added to the **Images** category of AFPDS converter. Checking this option converts images (having widths which are not multiple of eight) into AFP Segments with widths in multiples of eight.
New Features

DesignPro Manager

Shifting and Rotating Forms Using the Transformer Feature
A new feature Transformer is added to the Applications tab in the Navigation window. This feature lets you either rotate or shift forms. To do so:

1. Select the required form, drag and drop the form onto the Transformer icon.
2. The Transformations dialog displays.
3. From the Input Format drop-down list, select the required input type. You can select either Elixir Form or Elixir Legacy Form.
4. Click adjacent to the Input Format drop-down list in the Inputs area. The property dialog for the currently selected input format displays. You can specify properties for selected input format here.
5. From the Output Formats list, select the required output type.
6. Click adjacent to the required output format. The property dialog for the respective output format displays. You can specify the output properties for the selected format.

Note: The Paths column displays the full path of the destination folder where the generated output file will be placed. By default, this path is set to the default folders for these formats at drive:/Elixir. You can click adjacent to each path individually to specify a different destination folder in the Browse for Folder dialog.

7. From the Operations list, select the required option:
   - Rotate: displays the following options adjacent to the list:
     - Rotation: rotates the form by the specified degrees.
       - 0: does not rotate the form.
       - 90: rotates form clockwise at 90 degrees.
       - 180: rotates form clockwise at 180 degrees.
       - 270: rotates form clockwise at 270 degrees.
     - Mode: sets the mode to either AFP or Xerox.
       - AFP: sets the AFP mode.
       - Xerox: sets the Xerox mode.

Note: Mode options only display if Professional Toolset is installed on your computer.

- Shift: shifts the form using the values specified in the following entry boxes (located adjacent to the list).
  - X Shift: specifies the horizontal form shift, in dots per inch.
  - Y Shift: specifies the vertical form shift, in dots per inch.

8. To set the order of the two operations, select the required operation and move it using located on the right.
9. Click OK to rotate or shift the selected form.
DesignPro Graphics Editor

**Page Segment Dimensions**
You can load and display Page Segments using dimensions defined in OBD (Object Area Descriptor). To do so: From the Tools menu, select Options. Select the General category from the Options dialog. Check Use Image Size from Object Area Descriptor (OBD).

**Note:** If you uncheck this option, the Page Segments are loaded using dimensions calculated from the image data.

Fixes

DesignPro Form Editor

**Indent Settings Saved Correctly**
Indent settings for a paragraph containing tags are saved correctly in ELX format.

DesignPro Manager

**Form Files are Visible**
Form files no longer disappear while opening or closing forms from DesignPro Manager.

DesignPro VPPFA

**Opening Non-ASCII Data Files**
Non-ASCII data files open correctly in the Sample Data window.

DesignPro Graphics Editor

- **Specifying Highlight Color**
The default highlight color is correctly selected and displayed in Color bar when a new LP3 image is created.
  
  To set the default highlight color: From the Tools menu, select Options. Select the Image category from the Options dialog. From the Format area select Lp3, and from the Mode dropdown list select the required highlight color. Specify the required color in the Highlight Color drop-down list.

- **Image Conversion from JPEG to Page Segment**
  JPEG images using CMYK Color Model are converted to Highlight color Page Segments properly.

Converters

**FRM:**
Conversion from MS Word to FRM format
IMG and LGO images are properly converted and text is properly justified. In addition, new text can be inserted according to font direction and page orientation in Form Editor.
FSL:
Generating LGO Images
LGO images are properly generated if Use Legacy Format option is selected in the FRM converter properties dialog.

Note: To select this option: Open the Xerox FRM Resource Writer dialog and select the Resources, Images category. From the Image Type drop-down list, select Use Legacy Format. Selecting this option enables the Specify Legacy Text Files Path entry box below. Specify the path of the legacy text file in this entry box.

Transformation Suite 8.00.05

Fixes

DPTCLCU.exe

File Updates Properly
Installing this patch updates the DPTCLCU.exe binary properly and hence, correct version number is displayed.

Parsers

LCDS:
Media Orientation
LCDS parser sets the correct media orientation.

Converters

LCDS:
Relative Shift of Text Objects With Respect to Page Orientation Displays Properly
The relative shift of text objects with respect to page orientation works correctly.

DesignPro Tools Professional 3.00.04

New Features

Converters

Metacode:
Duplex Command Support
Duplex command support is now available for Normalized Metacode output.

DesignPro Manager

Service Configuration Dialog
- You can now add multiple paths in Path(s) to Monitor entry box, separated by semicolon (;), on Service Configuration dialog. When you select a folder from the Browse for Folder dialog, it appends to the existing list of folder paths instead of replacing them.
- If the path is removed or changed from the Path(s) to Monitor list, the indexing information for resources belonging to that path are also removed during indexing. You can now check Keep Indexing Information for Old Paths on Service Configuration dialog to avoid removal of such indexing information.
- Some generic changes to improve the performance are made.
Fixes

Parsers (FRM/FSL)

New Text Inserting Properly
New Text is inserted according to the raster font direction and page orientation in Form Editor.

Converters

FRM:
- Image (IMG) and Logo (LGO) files are now properly converted to FRM format.
- Unchecking Optimize in the Conversion category of Xerox LPS Resource Writer dialog justifies the text properly.

OGL:
Converting Text Characters of a Line at Differing Vertical Positions Properly
You can now properly convert the text objects where some text characters of a line are present at different vertical positions. OGL converter also retains the position of these text objects.

AFPDS:
Overlay Printing Properly
For proper printing of an overlay or a page, AFPDS converter now includes Presentation Text Descriptor (PTD) Format 2 in the Active Environment Group (AEG).

DesignPro Tools

Keyboard Mapping
The soft and real keyboard mapping in DesignPro Tools now conforms to the behavior in Elixir Application Suite when you check Use KMP in Tools, Options, Character Mapping dialog.

Elixir Viewer

PCL Files Opening Properly
PCL format files are opening properly in Elixir Viewer.

DesignPro Form Editor

- AFP Overlays Parsing Properly
  AFP Overlays (OVE) with segments, having internal offset set to -1, are parsing properly.
- New Patterns Adding Correctly
  Adding new patterns to forms using the Pattern Selector on the Common Attributes toolbar works correctly.
- Import and Export of Standard and Non-Standard Shades Working Correctly
  The import and export of standard and non-standard shade lists (XML) is working properly. In Hybrid toolset you can export both standard and non-standard shade lists while in Xerox toolset you can only export non-standard shade lists.
- Printing as Image without Object Shift
  When you check Print as Image in the Print dialog, the form prints properly and no object shifting occurs.
- Scroll in the Design Area
  While selecting the form objects, the Design Area scrolls automatically in the required direction: left, right, up or down.
DesignPro Manager

PCL Graphics Virtual Folder Added
In DesignPro Manager, a virtual folder for mapping PCL graphics is added under the Graphics node in the Resources window.

DesignPro Font Editor

Removing Font Prefixes
Now the prefixes 'C+digit' or 'X+digit' (for example, X0AR10BP, C0AR10NP.300) are removed only when AFP fonts are converted into other formats.

DesignPro VPPFA

End Graphics
Proofing runs correctly for a page format having End Graphics command in all directions except Back.

PrintDriver Pro

Granting Read and Write Access Rights
For proper working of PrintDriver, this installer performs the following actions:
- Assigns read & write access rights to "Everyone" group on drive:\Documents and Settings\All Users\Application Data\Elixir Technologies\ folder.
- Creates a file named DISK under drive:\Elixir\Pdnt\ folder (if it does not exist) and assigns the "Everyone" group rights to this file.

Note: Installing this patch on PrintDriver Pro grants these access rights to all users of DesignPro Tools applications.

Box Objects Converting Properly
Box objects in PDF documents are converting properly.

Transformation Suite 8.00.04

Fixes

Parser

FRM:
Merges Co-Linear Line Segments Properly
FRM parser merges co-linear line segments with similar properties (for example, thickness, color, shade, style, etc.) only.

LCDS:
Blank Pages Do Not Appear with RPAGE Command
The blank pages do not appear when RPAGE command occurs in the JSL file.

Converters

FRM:
Relative Shift of Text Objects With Respect to Page Orientation Displays Properly
The relative shift of text objects with respect to page orientation now works correctly in form files (FRM). For example, landscape text object appears properly on a portrait page and portrait text object appears properly on a landscape page orientation.
PageMiner 4.00.04

Fixes

Parsers (AFP)

Page Composition
Memory leakage issue is fixed and conversion of large AFP file format to other file formats (such as, PDF, TIFF and PCL) runs successfully. Temporary files are also deleted properly.

DesignPro Tools Professional 3.00.03

New Features

DesignPro Manager

Saving the Virtual Folder Directory Listing
You can save the directory listing of the selected virtual folder in the Resources window into a text file. To do so:
1. Right-click the virtual folder and select Directory Listing from the pop-up menu.
   The Save As dialog displays.
2. From the Save In drop-down list, select the required destination folder.
3. In the File Name entry box, specify a file name.
4. From the Save As Type drop-down list, select Text Documents (*.txt) if it is not already selected.
5. Click Save.
   All of the directory information of the selected physical folder saves in the specified text file. The directory information includes the name of the virtual folder, file names of all the resources in the folder along with their file extensions, file sizes (in bytes), date and time (when the resources were last modified).

Note: A check box Use Short File Naming Convention for Directory Listing is added to the General category of the Options dialog for providing compatibility with Elixir Application Suite. When checked, the folder contents are saved with short file names in the directory listing text file. When unchecked, complete file names are saved.
To open the Options dialog, select Tools, Options from the menu. In the General category, the Use Short File Naming Convention for Directory Listing option is selected by default.

Fixes

Appending File Extensions with File Names When Opening Files
In the Open dialog if you do not enter any extension after the file name, the DesignPro applications automatically append a file extension after the File Name. The extension selected in the Files of Types drop-down list is used. On pressing Enter, the file successfully opens in the respective DesignPro application.

Note: If more than one extension is available in the selected Files of Type (for example Image Files (*.bmp; *.jpg; *.jpeg; *.tif; *.pcx; *.png)) the first extension (*.bmp) is used.
**Converters**

**AFP:**
*Converting Word Documents to AFP Format*
Word Documents containing gray colored objects convert to AFP format properly when *Greyscale* option is specified in the *AFPDS* dialog.
To select this option: In the *PrintDriver Wizard*, click *Edit* (located in front of the selected entry) to open the *AFPDS* dialog. In the *Color* category, select *Greyscale* from the *Color Format* area.

**FRM:**
*Xerox Format Fonts Print Correctly*
Xerox format fonts print correctly in DesignPro Tools and the behavior is compatible with Elixir Application Suite (EAS). The FRM converter replaces the Null characters with the Spacing characters.

**PCL:**
*Reverse Fonts*
Text with reverse fonts (i.e. white text on black background) is printing correctly in PCL.

**DesignPro Font Editor**

*Font Conversion from Elixir Format to Xerox Format*
The point size information of Elixir Legacy format fonts (HDR) is preserved correctly when saving to Xerox format fonts (FNT).

**Note:** You can view the point size information of a font by clicking *Resize*, in the *Transform* toolbar. The point size information displays in the *Toolbox*.

**DesignPro Form Editor**

- **Images Added to Forms**
The image file name displays correctly in the status bar when mouse pointer is placed over the image in the current form.

- **Image Handling**
When saving a form to FSL output format, the image orientation is handled properly in accordance with the landscape and portrait page orientations.

- **Palette Lists**
Palette lists are imported and exported successfully.

**Note:** To import or export a Palette list, do one of the following:
- From the *File* menu, select *Import, Palette List* to import a palette list or select *Export, Palette List* to export a palette list.
- In the *Common Attributes* toolbar, click from *Color Selector*. The *Color Picker* dialog displays. Click *Open Palette*, to open/import a color palette or click *Save Palette*, to save/export a color palette.
DesignPro Graphics Editor

- **TIFF Images Size**
  The size of the TIFF images display correctly.
  
  **Note:** To view the image size, from the **Image** menu, select **Attributes**. The image size displays in the **Width** and **Height** entry boxes of the **Attributes** dialog.

- **Text Alignment**
  When you enter the text using the **Text** tool with **Align Left**, and **Wrap Text**, selected on the **Toolbox**, the text aligns correctly on the right side after clicking **Justify**.

DesignPro Visual PPFA

- **2DMAXI Barcode Dimensions**
  The 2DMAXI Barcode fields have fixed dimensions as 28.14 mm X 26.91 m. These dimensions display correctly in the Design Area. After proofing, the correct dimensions also display in Elixir Viewer.

- **Color Palettes**
  Color Palettes are imported and exported successfully while editing forms.
  
  **Note:** To open or save Color Palettes: In the **Common Attributes** toolbar, click from **Color Selector**, . The **Color Picker** dialog displays. Click **Open Palette**, to open/import a color palette or click **Save Palette**, to save/export a color palette.

Parsers (LCDS)

**Online Job Printable Data**
LCDS parser correctly recognizes the Metacode record starting after the PCC byte for online job printable data. The output displays correctly in Elixir Viewer.

DesignPro Tools Professional 3.00.02

New Features

Converters (Image)

**EAS Compatible Image Conversion**
- A new checkbox **EAS Compatible Brush Pattern** is added on the **Drawing Options** category of the **Image** converter to maintain image shadings in output.
- Another checkbox **Preserve EAS Compatibility** is added on the Image category for **IMG** Image Format to create IMG output similar to Elixir Application Suite (EAS).
  
  Checking both these options during ELX to IMG conversion maintains the image shading and image prints correctly for IMG format.
**Parsers (GDF)**

**Inter-Word/Inter-Character Spacing**
A new drop-down list **Additional Spacing** is added on the **Main** category of the GDF/Elixir Form parser. To use this option, also select **Advanced** under the **Text Formatting** area of the **Main** category.

Selecting either **Inter-Word** or **Inter-Character** from the **Additional Spacing** drop-down list opens an ELX form with the correct inter-word or inter-character spacing applied on all the text objects.

**Fixes**

**DesignPro Manager**

- **AFP Font Name Prefix**
  When you convert a raster font to AFP font and select either **Outline (Type1 PFB)** or **Outline (CID)** from the **True Type Fonts Output** drop-down list in the **Fonts** category of the AFPDS converter, DesignPro Manager appends the X0/C0 prefix instead of XZ/CZ to the output font name (as the converted font is a raster font).
  However, with the same AFPDS converter settings (above), DesignPro Manager appends the XZ/CZ prefix to the font name only if the input font is a vector font.

- **Printing Single Page Portrait Documents**
  Previously, when you dropped single page portrait documents on the **Printers** icon in DesignPro Manager, the pages were printed as landscape. This issue is fixed. Moreover, some images were overlapping text during printing which is resolved.

- **Correct File Filters**
  When you select a virtual folder from the **Resources** window and copy files into that folder, only the files matching the selected file filter display in the associated file pane.

- **TrueType to AFP Fonts Conversion**
  You can generate AFP fonts from TrueType fonts with custom font names.

**DesignPro Form Editor**

**TrueType Font Duplication**
When you copy a text object from one form to another, duplication of TrueType font does not occur.

**DesignPro Visual PPFA**

**Font Pair References**
Font pair references having the same character set with different codepage will remain preserved in AFP/OBJ PageDef.

**DesignPro Graphics Editor**

**Text Editing**
When you enter the space character using the Text tool with **Justify**, and **Wrap Text**, selected on the Toolbox, text does not line up on the right side.
**Converters (GDF)**

**Correct Image size for A4 Paper**
While converting a Word document to ELX format through PrintDriver, the image size is calculated properly for A4 paper size and hence, conversion to FRM output works fine.

---

**DesignPro Tools Professional 3.00.01**

**New Features**

**DesignPro Manager**

**Conversion to PCL Image Format**
You can now convert images to PCL format using DesignPro Manager. To do so:

1. Drag and drop the selected image onto the Conversions icon.
   
   The Conversions dialog displays.

2. From the output area, check **PCL** to convert the image to PCL format.

3. Make the necessary changes in the associated properties dialog.

4. Click **OK** to convert the image to PCL format.

**PrintDriver Pro**

**Limit for Naming Resources**
A new option **8 char. Job ID** is added to the PrintDriver Options dialog. This option lets you specify eight characters for the form and image names.

To specify eight characters for form and image names generated via PrintDriver:

1. Select **File, Print** from Word document.

2. From the **Print** dialog, locate **Elixir Print Driver Pro** from the list of available printers.

3. Click **Properties** in the **Print** dialog.
   
   Elixir PrintDriver Pro Document Properties dialog displays.

4. Click **Advanced**.
   
   Elixir PrintDriver Pro Advanced Options dialog displays.

5. Click **Output Format** under **Document Options**.
   
   A Properties button displays.

6. Click **Properties**.
   
   PrintDriver Wizard Options dialog displays.

7. Click the **Options** tab.

8. Check **8 Char. Job ID**.

9. Click **OK**.

**Note:** To specify eight characters for resources generated when converting to ElixirGDF format forms, click **Edit** (located in front of the selected entry) in the PrintDriver Wizard - File and Format Setup dialog to open the ElixirForm dialog. Select the **Main** category and from the **Max. Length of Resource Name** drop-down list, select **8**. Click **Apply** and **OK**.
Fixes

DesignPro Visual PPFA

- Elixir PageDefs Saved Properly
  The Elixir PageDefs are saved correctly after removing the unused shades from the Resource Manager. Such PageDefs can be converted to AFP PageDefs and reopened in Visual PPFA without generating any error messages.

- Documents Composed Correctly
  While proofing document pages containing both NUP partitions and conditions for switching media are composed correctly.

DesignPro Font Editor

- Lower Limit Removed for Glyphs
  The lower limit set for the Distance Above and Below options in Font Editor has been removed. The glyphs are no longer restricted to be placed within the cell’s upper and lower boundaries.
  
  Note: The Distance Above and Below options are set in the Font Properties dialog.

  To set the options: Open the required font in Font Editor, click on the Formatting toolbar to display the Font Properties dialog. Enter the required value in the Distance Above and Below entry boxes.

- Image Import Size Increased
  You can import images with width and height greater than 255 pixel value into a relative metric font in Font Editor.
  
  The maximum height and width allowed for images is 32767 in relative units. Font Editor operates in Pixel mode and the equivalent maximum limit depends on the font resolution, maximum ascender, maximum descender etc.

Parsers (PPFA)

FormDefs Parse Correctly
PPFA source FormDefs containing OVERLAY commands defined using both local name and user access name parse correctly.

Converters

OGL:
Outline Fonts Generated Correctly
Multiple Outline fonts with the same code page and character sets but with different heights are treated as separate fonts.

FRM:
- Correct Characters Called in FRM
  Characters used to call LGO in FRM now match with the characters in LGO during conversion.

- Resampling and Distortion Removed
  The IMG images are not resampled and no distortion is produced in the image if Preserve EAS Compatibility is checked during conversion.
  
  Note: This option is available in the Image category of the Xerox LPS Resource Writer dialog.

- Correct Character Spacing is Generated for Xerox Fonts
  FRM converter generates correct character spacing values for Xerox fonts.